Homework #3 Answers

1.  There are 124 variables, and there were 279 participants.
2.  It can be found in the “Compare Means” submenu.
3.  Anxiety was their predominant childhood emotion.

4.  The question asked, “Compared to most people… How satisfied are you with your life?”

5.  The median was 6.0
6.  56.6% rated themselves as a 4 or lower on the 9-point scale regarding frequency of playing sports.

7.  The frequency distribution for beauty concerns is more negatively skewed.

8.  Yes, based on the scatterplot, people who eat more tend to have poorer health, supporting the hypothesis.  [This question originally had a typo regarding which variables to use, so I will accept any reasonable interpretation of a scatterplot]
9.  The correlation (r = -.06) is near zero and unreliable.  Thus, one’s level of sadness is virtually unrelated to their friends’ level of happiness, which is somewhat surprising.  People may not be affected by the mood of their friends.  
10.  Of these four variables, attractiveness is most highly related to depression.  People who are attractive tend to be less depressed.  Depression is more related to attractiveness than loud music preferences, parental fighting, or object relations.
11.  The effect size for the relationship between depression and attractiveness is “medium”.
12. Using sleep problems, stress, and depression to predict somatization, R = .51, R2 = .26.  Thus, these predictors explain 51% of the differences in somatization, a large effect.  The equation used for predicting somatization is as follows:
Somatization’ = 1.986 + .238*(sleep problems) + .230*(stress) + .176*(depression)

13. (Extra credit)  Answers will vary. Students received +1 for a correct or elaborative answers and +.5 for any attempt at an answer.
Demerits: No cover page = -1, No Output = -3
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Homework Assignment #3
Due Tuesday, February 12th (Exam Day)

For this assignment, you will learn how to make basic statistical calculations using a program called SPSS.  For the assignment, make a cover page.  Then, type up a neat “answer page.”  After the answer page, provide a copy of all of your SPSS Output – the numbers, figures, and tables from SPSS.  Please print out two copies of your complete assignment – one for yourself and one for me – because I will be posting answers online rather than passing back assignments.
I will deduct 0.5 points for every major spelling error or major punctuation failure (e.g. not capitalizing the first word in a sentence).  
Please type all answers in complete sentences, using your own words.  Work independently.  All questions you need to answer are in blue text.
	Section 1: Introduction to SPSS and the Classroom Survey Data File


A. Getting Started:
· a) All computer assignments in this course are designed to be tutorials.  They are substitutions for detailed, expensive workbooks.  Please refer back to these assignments later in the year, as needed, when you get stuck (e.g. term paper time).


· b) SPSS is a computer program you will need for the computer assignments.  Most students work on the assignment in the Woldt computer lab (free printing); however, it is also available in many of the computers in the library and around campus.  Different computers have different versions, but they are all very similar.  I use SPSS 13.0, so if you run into problems due to a different version, let me know, but they are pretty much all the same.  You may be able to find a free trial version on the web, if you prefer.

· c) Go to the course web site (http://www.psychmike.com/psy211/):

· d) How do I find our data file?  From the course homepage, you can click on the “Survey” link.  It takes you to a page that reminds you that our survey data file is saved on BlackBoard so that not just anyone can access it.  To find it, log on to BlackBoard, and find the data.sav file in the Course Materials folder.  Download the file.  The easiest way to open it is by double-clicking on it.  If this does not work, open the program SPSS; go to the File menu, point to Open, and choose “Data…” – find and open the file.
· e) Where can I find out more about each survey question? From the course homepage, you can click on the “Survey” link.  It takes you to a page with a link to a “data guide,” which you can click on, or you can go directly to this address: http://www.psychmike.com/psy211/data_guide.doc
This file tells you the variable number, a name I made up for each “construct” (variable), the question we asked in the survey, the type of variable (continuous or categorical), and how the responses are coded in the data file.  This is very helpful for interpreting results.  
· f) What if I get suck?  From the course homepage, click on the “SPSS Manual” link (or go to this address: http://www.psychmike.com/psy211/labmanual.pdf).  This will load a free, public domain .pdf file describing how to solve many statistical problems using SPSS.  It’s a great guide in case you ever get stuck, but hopefully my instructions will be enough.  E-mail me if you get stuck.  You can ask a friend for help, as long as they do not show you how to do a specific homework problem.  
B. Exploring the data file:
· a) Using the above information, open the classroom survey data file (data.sav) in SPSS.  A large, detailed data file will open.

· b) Once the data file pops up, look at the bottom left side of the screen.  You should see two tabs labeled “Data View” and “Variable View” and you can click back and forth on them to see how they differ.

· c) In “Data View” each row (across) represents a specific participant.  Each column (up and down) represents a particular variable.  For example, participant #4 has a “0” for the variable “physical” and a “1” for the variable “smoker”.  Similarly, participant #80 has a “1” for the last variable in the file “inkblot14”.  Since we don’t automatically know what these numbers mean, the data on their own would be very confusing.  
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· d) In “Variable View” you get more information on the variables, including how they are coded.  In the first column (“Name”), you see the name of the variable; it’s a pretty crummy name because only certain characters can be used.  In the fifth column (“Label”) is a clearer name for each variable.  In the sixth column, there is information on how some of the variables are coded.  For example, find the fourth variable, “athlete” and click on the box in the “Label” column; inside that box, a small gray box with three dots will appear, and if you click on it, it will tell you how the data are coded.  It shows that a “0” means “No” – not an athlete, and a “1” means “Yes” – an athlete.  If you need more detail on a variable, see the data_guide.doc file (see Section 1Ae above).
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· e) Regardless of whether you’re in Data View or Variable View, you will still have the same menu commands at the top of the window (File, Edit, View, Data, etc.).  Look through each menu to get an idea of what functions are available
· f) File menu: opening documents, saving, printing, etc.

· g) Edit menu: copy, paste, etc.

· h) View menu: not usually used

· i) Data menu: advanced commands for combining data files, excluding certain participants in analyses, and other commands not usually needed in PSY 211

· j) Transform menu: included commands for doing computations and recoding variables in various ways
· k) Analyze menu: all sorts of commands for statistical analyses; this is the main menu we will use in PSY 211; look it over thoroughly and see if you recognize any of the words

· l) Graph menu: all sorts of commands for making graphs and figures; we will use this menu occasionally, and some commands may already look familiar
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Question #1:  
How many variables are in the data file?  How many participants?
Question #2: 
Within the Analyze menu, where do you find the “Independent-Samples T Test…” command?
Question #3:
What does it mean if someone has a “4” for variable #22 “Negative Emotion (Childhood)”?
Question #4:
What was the exact wording we used in the survey for question #92 “Life Satisfaction”?

	Section 2: Basic Statistics Operations


A. Frequencies Command
· a) Go to the Analyze menu, point to Descriptive Statistics, and choose “Frequencies…”.  This will allow us to make a frequency table and obtain other useful statistics.
· b) In the window that pops up, click on the Statistics button.  Select the Mean, Median, Mode, and Standard Deviation. Then, click on the Continue button.  
· c) In the initial pop-up window, now click on the Charts button.  In the window that pops up, choose Histogram.  Then, click the Continue button.
· d) In the initial pop-up window, move variable #56 “Hand Washing” from the list on the left to the box on the right, telling SPSS that we want statistical information for this variable (you could choose multiple variables if you like).  Then, click on the OK button.

[image: image15.png]Frequencies: Statistics

Petcertie Valuss
I™ Quartles

™ Cut poits for
™ Bercentiefs)

equal graups.

Dispersion

¥ id devielior] [ Minimum

I™ Variance
I” Range

I~ Masinum
I” SE mean

Central Tendency,
¥ Mean

% Megian

7 Mode

I Sum

Continue.

Cancel

Help

™ Vales are group midpoints

Distbutian
I™ Skewness

I™ Kutosis




 [image: image16.png]Frequencies: Charts
Chat Type
 Nore
 Barchats
P chatts

& Hisiogans

I~ With nomal curve

Continue.

Cancel

Help





[image: image17.png]M Frequencies

51 Road Rage 0.4 R enatels)
:52 coon P,:M:ms B ® 56, Hand Washing (na
53, Food Thoughts
54, Pop Dinking ¢
55, Ganbing gl

57, Cell Phone Use
® 58 Somatization [s
53 Worying o

¥ Display frequency tables

Statstcs.. | Chats.. | Fomat





· e) In the Output, you should find that the mean on the 1-9 scale is 8.1, median = 9.0, mode = 9.0, SD = 1.52.  Most people say they always wash their hands.  You should also see a nice frequency table.  For example, it shows that 4.7% of people marked a rating of “5” on the 9-point scale, and 9% of participants marked a rating of “5” or lower (note that SPSS usually makes its frequency tables upside down, with lower numbers on top).
Question #5:
Repeat the above Frequency Command steps for variables #64 “Beauty Concerns” and #65 “Play Sports”.  What is the median rating for beauty concerns?
Question #6:
What is the cumulative percentage of people who rated themselves as a “4” or lower on the “Play Sports” variable?
Question #7:
Both of the variables have messy-looking histograms, but which variable is more negatively skewed?

B. Scatterplot

· a) To make a scatterplot, go to Graphs menu and choose “Scatter/Dot…”.  In the window that pops up, make sure “Simple Scatter” is selected and click the Define button.

· b) In the next window that pops up, we will choose one variable for “X Axis” and one variable for “Y Axis”.  Usually, if we think one variable is the cause, we put it on the X axis.  
· c) Let’s hypothesize that stress causes crying.  Move variable #61 “Stress” to the “X Axis” box and variable #60 “Crying” to the “Y Axis” box.  Then click on the OK Button.
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· d) In the Output, double click on the gray area of the scatterplot.  A new window will pop up.  In the pop-up window, you’ll see your scatterplot again and above it, there are many little buttons with pictures.  The buttons all look very similar, but if you point your arrow over it, some pop-up text should describe the button.  Find one that says “Add Fit Line at Total” and click on it (if you can’t find it, go to the Elements menu, and choose “Fit Line at Total”).  This makes a best fit line appear and another small popup box appear.  Close this new pop-up box and the previous one, taking you back to the Output, which is now updated with the best fit line.
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Question #8:

You hypothesize that eating too much causes poor health.  Make a scatterplot using variable #86 “Physical Health” and #48 “Eat too Much”.  Add a best fit line.  Based on the scatterplot, does it look like your hypothesis is supported? (Remember, the “cause” goes on the X Axis).
	Section 3: Correlation and Regression


A. Correlation
· a) To run correlations, go to the Analyze menu, point to Correlate, and choose “Bivariate…”.
· b) In the window that pops up, select any variables (at least two) that you’d like to correlate.  If you choose more than two variables, SPSS will run a correlation for every possible pairing of two variables.  Try selecting the Big 5 personality traits, which are variables #103-#107, and move them from the list on the left to the box on the right.  Then click on the OK button.
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· c) The Output should look something like the following table:
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· d) Notice that each variable is listed along the side and the top.  I have put green boxes around them above.  To find information on how two variables correlate, choose one variable on the side, one on the top, and track where they meet in the body of the table.  For example, to see how agreeableness correlates with neuroticism, you could find agreeableness on the side, neuroticism on the top, and track where they meet (the red box).  Inside the red box, you see three numbers.  The top number is most relevant; it is the correlation coefficient, r = .017 (or rounded, r =.02).  The numbers below it are less important, but the middle number is called a “p-value” or “significance value” and indicates the probability that the result might be due to chance (p = .77 in this case); there is about a 77% chance we’d get a correlation like this by chance, so it’s an unreliable finding; if the p-value is less than .05, it is reliable or trustworthy.  The bottom value tells the sample size, 279.  The correlation between agreeableness and neuroticism is weak and unreliable.  
· e) All significant or reliable correlations will have a star (*) by them, and p is < .05.
· f) If a p-value says “.000” it’s because SPSS is rounding down too much.  Consider these values to really mean “approximately zero” or “p < .001”

· g) If you compare a variable to itself, you’ll see it always correlates r = 1.00.

· h) The correlation between neuroticism and openness to experience (blue box) is r = -.13.  Because it has a star (*) and p < .05, we know it is reliable.  Thus, there is a small, reliable, negative relationship between neuroticism and openness.  People who are neurotic (sad, anxious, angry) are slightly less open – not too surprising.

Question #9:
What is the correlation between variable #95 “Sadness” and #94 “Friend Happiness” and what does this finding tell us?

Question #10:

Which of the following variables is most strongly correlated with #68 “Depression”?  
#70 “Parents Fought Growing Up”
#91 “Object Relations”

#97 “Attractiveness”

#69 “Listen to Loud Music”

Question #11:

Based on question #10, what is the effect size for the correlation between Attractiveness and Depression?
B. Regression

· a) To run a regression, go to the Analyze menu, point to Regression, and choose Linear.
· b) Put the “causes” or predictors in the “Independent(s)” box (there can be one or more causes) and put one variable, the “effect,” in the “Dependent box”.  I will use #41 “GPA (High School)”, #43 “ACT Score”, and #107 “Conscientiousness” to predict #42 “GPA (college)”.  Put the first three variables in the Independents box, and the last one in the Dependents box.  Then, click on the OK button.
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· c) The Output shows that R = .54.  R2 = .29, so high school GPA, ACT score, and level of conscientiousness account for 29% of the differences in college GPA.  (See lecture notes if more detail is needed).

· d) The formula for predicting college GPA is the following:
College GPA’ = 
0.639  +  (0.441)*(HS GPA)  +  (0.023)*(ACT Score)  +  (0.081)*(Conscientiousness)

· e) If we know someone’s HS GPA, ACT Score, and Conscientiousness rating, we could predict their College GPA.  For example, if these values were 4.0, 21, and 5, then we would predict a GPA of 

College GPA’ = 
0.639  +  (0.441)*(4.0)  +  (0.023)*(21)  +  (0.081)*(5)  = 
0.639  +  1.764  +  0.483  +  0.405  = 3.291
Question #12:

You hypothesize that sleep problems, stress, and depression, will contribute to somatization (physical aches and pains, particularly when overwhelmed).  Run a regression using #52 “Sleep Problems”, #61 “Stress”, and #68 “Depression” to predict #58 “Somatization”.  What is the value of R?  What is the value of R2?  What is the equation for predicting somatization?  What conclusions can be drawn?
Extra Credit:

Using the equation in Section 3Be (the College GPA formula), predict your own college GPA (or a friend’s) based on the three predictors.  You may need to refer to the data guide to make the conscientiousness rating.  Does the formula do a good job of predicting?  
